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Цель работы: Знакомство с пакетом Quartus II создание нового проекта

Основные сведения:
· Различные способы ввода поведенческих , потоковых и структурных описаний проекта
· Интегрированные средства помощи для создания сложных проектов Mega Wizard &    SOPC
· Система синтеза проекта
· Система размещения внутренних ресурсов и разводки ПЛИС
· Система моделирования проекта
· Система временного анализа и анализа потребляемой энергии проекта
· Система программирования ПЛИС
· Средства оптимизации быстродействия проекта - LogicLock
· Система интеграции с другими САПР
· Система проектирования блоков цифровой обработки сигналов (DSP)
· Поддержка использования IP-модулей (IP-Cores - от англ. Intellectual Property – интеллектуальная собственность)
· Поддержка ОС – Windows, Linux, Solaris, HPUS

Способы ввода описания проекта в рамках пакета Quartus II: 

· Текстовый ввод (VHDL, AHDL, VerilogHDL)
· Посредством редактора памяти (Hex-, Mif-файлы)
· Схемный ввод (Block Diagram File)
· Импорт проекта из других САПР в виде списка соединений (EDIF Netlist File)
· Использование мегафункций фирмы Altera и IP- модулей
· Сочетание различных способов

Текстовый ввод описания проекта:

· Возможности:
· Нумерация линий 
· Использование заготовок языковых конструкций
· Отображение ключевых слов цветом 
· Используемые языки
· AHDL (Altera Hardware Design Language) - <файл.tdf>
· VHDL (Very High Speed Integrated Circuit Hardware Description Language - язык описания аппаратных средств сверхбыстродействующих интегральных микросхем) - <файл.vhd>
· VerilogHDL (Verilog Hardware Description Language) - <файл.v>

Схемный ввод описания проекта:

При схемном вводе описания проекта могут использоваться:
· Простейшие логические элементы (примитивы)
· Параметризируемые модули
· Мегафункции компании Altera
· Ранее созданные компоненты


Вход в систему

Для входа в систему Quartus II v.4.1 Web Edition необходимо на рабочем столе Windows дважды щелкнуть мышью пиктограмму системы: 

	Работа в системе начинается либо с выбора уже существующего проекта File->Open Project… (Ctrl+J), либо с создания нового проекта File->New… (Ctrl+N). 
Создайте новый проект: выберите из меню File пункт New Project Wizard… - мастер создания новых проектов. В открывшемся окне нажмите кнопку Next и в окне для задания текущей директории проекта заполните все строки (в данном случае текущий проект будет назван top и будет создана директория по адресу C:/Program Files/altera/Primer- рис.1), нажмите кнопку Next несколько раз до тех пор, пока не дойдете до окна «Device Family».

           Рис.1 Меню задания текущей директории проекта


   В окне «Device Family» выберите семейство «Cyclone», а на вопрос: «Хотите ли вы выбрать конкретную модель?» ответьте утвердительно. 
   В следующем окне «Select a Target Device» значение Speed Grade выберите равным 8, а тип кристалла – EP1C3T144C8 – это марка ПЛИС типа FPGA, использованной в лабораторном стенде.

Следующие файлы автоматически генерируются мастером New Project Wizard:
 - Project Configuration File – файл хранит конфигурацию проекта, Имя, задаваемое по умолчанию – <имя_проекта.quartus>. Может редактироваться в текстовом редакторе.
 - Project Settings File - файл с установками проекта - имя, задаваемое по умолчанию – <имя проекта.PSF >.


Создание нового файла проекта

	После создания нового проекта произведем создание нового файла проекта. Меню File пункт New… в открывшемся диалоговом окне Рис.2 выберем тип создаваемого файла. 

           
Рис.2 Меню выбора типа файла проекта

	На закладке Device Design File можно выбрать:

- АHDL File – создать файл с описанием проекта на языке AHDL,
- Block Diagram/Schematic File – создать описание проекта в виде схемы, 
- EDIF File – файл Electronic Design Interchange Format, 
- VerilogHDL File – создать файл с описанием на языке VerilogHDL, 
- VHDL File – создать файл с описанием на языке VHDL.
Создадим файл, содержащий описание схемы. Для этого выберем пункт Block Diagram/Schematic File и нажмем OK. На рабочей панели Quartus II откроется окно с файлом Block1.bdf, в котором и создадим наш проект.

Файлы графического редактора, созданные в Quartus II не могут быть открыты в системе Quartus 1.1 и более ранних версиях, включая САПР МАХ PLUS.
Порядок работы:
1. Запустить Quartus II
2. Создать новый проект
3. Создать файл проекта в виде схемы
4. Ознакомиться с основными функциями 
4. Вставить примитив в проект
6. Открыть демонстрационный проект demo1
Контрольные вопросы:
1. Основные функции программного пакета Quartus II
2. Типы файлов в проекте Quartus II
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Графический (Схемный) редактор позволяет увеличивать или уменьшать масштаб изображения проекта на экране, выбирать размер шрифта, задавать стили линий, получать зеркальное отображение, поворачивать выделенные фрагменты на 90, 180 и 270 градусов, задавать размер и ориентацию текущего листа схемы (рис. 3).

При создании схемы могут использоваться:
· Простейшие логические элементы, триггеры, элементы ввода-вывода и другие элементы (primitives);
· Параметризируемые модули (мегафункции, megafunctions) - созданные фирмой Altera модули с нефиксированными параметрами; 
· Ранее созданные (в текстовом или графическом редакторах) компоненты.
Для операций создания схемы применяется следующая панель инструментов (рис. 3).
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     Рис. 3 Свойства панели инструментов
*  “Rubberbanding“ или “Rubber-banding“ – от англ. «эластичное соединение, соединение резиновой нитью» (в компьютерной графике) – при выбранной функции соединение (цепь, проводник или шина) останется неразрывно связанным с элементом при его перетаскивании в другое место.
Рассмотрим процедуру создания простой схемы на примере. На рис. 4 приведена схема, которую следует ввести в графическом редакторе..


	       
		     Рис. 4. Логическая схема

В схеме используются два элемента AND2 (2И) и один элемент  NOR2 (2ИЛИ-НЕ). Эти элементы  являются  стандартными для системы Quartus II (т. н. «примитивы»), доступ к ним осуществляется как показано на рис. 5. Также можно просто ввести наименование элемента в поле «Name».


			  
			         Рис. 5 Окно Symbol Tool
Подключите ко всем внешним контактам схемы входные и выходные элементы и дайте им названия (например, А1, А2, А3, А4 и F)  (рис. 6);

     
                       Рис. 6. Логическая схема с подключенными внешними элементами

На рис. 7 показано как задать имя и тип элементов ввода-вывода в схемном редакторе.
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Рис.7 Окно Pin Properties
Рисование цепи

Создание новой цепи осуществляется путем рисования ее фрагментов. Фрагмент цепи - это отрезок, соединяющий два объекта. Объектом является либо контакт (входной или выходной) элемента, либо цепь. Таким образом, фрагмент цепи соединяет контакт с контактом, контакт с цепью, цепь с контактом.
Рисование фрагмента цепи выполняется не прорисовкой конфигурации соединения, а только указанием соединяемых объектов, фрагмент цепи прорисовывается автоматически.
Можно начать рисование фрагмента цепи и на свободном поле, но закончить его вы должны на объекте.
Щелкните на панели инструментов (рис. 3)
1.  кнопку «Рисование цепи» (Orthogonal Node Tool).  Курсор примет вид перекрестия с маленькой пиктограммой цепи.
2. укажите щелчком левой клавиши мыши первый объект или желаемую точку на свободном поле (начало фрагмента цепи), затем вторым щелчком - второй объект (конец фрагмента цепи). После этого на экране появится автоматически прорисованный фрагмент цепи.
3. Повторите действия пункта 2 для рисования всей цепи.
Для перемещения цепи:
1. Переместите курсор на цепь и нажмите левую клавишу мыши.
2. Не отпуская клавишу, переместите цепь на требуемую позицию и отпустите клавишу мыши.
Для удаления цепи:
1. 	Щелкните мышью цепь, которую вы хотите удалить. Она будет выделена синим цветом. 2.	Нажмите на клавиатуре клавишу Delete.
Присвоение имени цепи:
1. Щелкните правой кнопкой мыши на цепи, которой вы хотите присвоить имя. Откроется окно Node Properties (рис. 8).
2. Введите имя и нажмите кнопку OK.


 (
Не отображать имя цепи 
)

	            Рис. 8 Окно Node Properties
Задание констант «0» и «1»
Для подачи на вход элемента постоянного сигнала «0» необходимо подсоединить к нему символ «земля». Для этого из библиотеки элементов (кнопка «Symbol» на рис. 3 или выберите команду Edit->Insert Symbol) необходимо извлечь элемент с именем GND.
Для подачи на вход элемента постоянного сигнала «1» необходимо подсоединить к нему символ «питание». Для этого из библиотеки элементов  необходимо извлечь элемент с именем VCC. Элементы удобно выбирать, задавая их имя в поле «Name».
	  	
Рисование шины
Для более наглядного представления схемы и создания удобств ее рисования в системе предусмотрено использование шин.
Шина - это совокупность одиночных проводников, изображаемая на рисунке одной утолщенной линией.
Имя шины состоит из идентификатора и индексных пределов, заключенных в квадратные скобки: BUS_NAME [X..Y], где X и Y - целые числа больше или равные 0.
Каждый проводник (сигнал), входящий в шину, получает имя шины и индекс: BUS_NAMEN, где N - индексное значение, заключенное между X и Y. Например, шина DATA[3:0] представляет набор дискретных сигналов:
DATA3, DATA2, DATA1, DATA0,
здесь DATA3 - старший бит шины,
а шина DATA[0:3] представляет тот же набор сигналов, но в обратном порядке:
DATA0, DATA1, DATA2, DATA3,
здесь старший бит шины - DATA0.
Это позволяет изменять соединения в схеме без удаления и перерисовки шинных соединений, для этого достаточно в имени шины поменять местами индексы X и Y.


Имя шины не должно заканчиваться цифрой. Иначе могут быть непредвиденные подключения. Например, шины DATA1[0:7] и   DATA[0:10] совместно используют сигнал DATA10, который               является членом обеих шин.

Для примера приведем схему шинного соединения:
  
  
   Рис. 9. Шина BUS[5..0]c подключенными контактами

Как видно из рис. 9 выходы QА … QЕ сдвигового регистра (Shift Register) получают имена QА … QЕ и выходят на некую комбинационную схему.
Следует заметить, что проектирование только в графическом редакторе является непрофессиональным. Связано это с тем, что зачастую синтезируемые логические функции достаточно громоздки, и рисовать полученную комбинационную схему весьма долго и трудоемко, к тому же теряется прозрачность решения. Создавать проект только в текстовом редакторе тоже не следует по той же самой причине - теряется наглядность. Поэтому разработка любого цифрового устройства должна носить «тексто-графический» характер
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1. Порядок выполнения работы
Шаг 1: С помощью утилиты Pin Planner выполните назначения контактов и стандарта ввода/вывода. 
1. В меню Assignments выберите команду Pin Planner. 
 
Напоминаем, вы можете открепить окно Pin Planner от основного окна САПР QuartusII и увеличить масштаб изображения.
2. Убедитесь, что в открывшемся окне микросхема отображается в режиме Top View. Если это не так, то выберите команду Package Top в меню View. 
3. Убетитесь, что в панели инструментов утилиты Pin Planner выбран режим Show I/O Banks (кнопка   активна). Если это не так, то  выберите его. Этот же режим можно задать из меню View. 
4. Выберите режим интерактивной проверки назначений контактов ввода\вывода Live I/O. Для этого нажмите кнопку  на панели инструментов или выберите команду Enable Live I/O Check из меню Processing в окне Pin Planner. 
5. В меню View (окно Pin Planner), выберите команду Live I/O Check Status Window. 
Эта команда открывает небольшое окно, в котором отображается информация об ошибках и предупреждениях при назначении контактов ввода/вывода. Обращайте на него внимание в процессе выполнения задания. Если появляется указание на ошибку или выдается предупреждение, проверьте окно Messages в основном окне Quartus II. Вы уже должны обратить внимание на три предупреждения. Эти предупреждения (unset junction operating temperature и Reserve All Unused Pins setting) могут быть проигнорированы.

6. В окне Groups List (Pin Planner), выделите входную шину dataa. Затем, удерживая нажатой левую кнопку мышки, перенесите шину dataa из окна Groups List в секцию IOBANK_2. 
Изображение секции IOBANK_2 должно измениться, и будет указывать на то, что банк I/O Bank 2 содержит 8 назначенных контактов из 43. Назначение сигналов банку ввода/вывода позволяет трассировщику разместить данные сигналы в любом месте в пределах указанного банка. 
7. В окне Groups List, нажмите правую клавишу мыши на шине dataa и выберите команду Node Properties из контекстного меню. 
 
8. В диалоговом окне Node Properties в строке I/O standard для шины dataa установите значение 2.5 V. Нажмите OK. 

 
Обратите внимание, что в окне полного перечня контактов отображаются внесенные изменения стандарта ввода/вывода для каждого сигнала шины dataa. Назначение контактов и стандарта ввода/вывода можно выполнять и в данном окне (All Pins list).  Следует заметить, что отдельные назначения, сделанные в окне All Pins list имеют приоритет перед групповыми назначениями, сделанными в окне Groups list. Лучший способ выполнения назначений для шин или групп сигналов - это задать назначения для названия группы (т.e. data[7..0]) в окне Groups list. 
9. Используя окно Package View или окно All Pins List, назначьте  для шины datab банк IOBANK_2. 
10. Установите значение I/O Standard для шины datab равное 1.8 V с помощью диалогового окна Node Properties. 
Вы должны заметить появление сообщений об ошибке в окне утилиты Live I/O Check Status Window и окне сообщений САПР QuartusII. Не пытайтесь пока устранить проблему. Наша задача – проверить реакцию компилятора. 
11. Назначьте для выходной шины q банк IOBANK_3 и установите I/O standard равный 1.8 V. 
12. Назначьте шинам адреса read и write банк IOBANK_3 и установите I/O standard равный 1.8 V. 
13. В окне All Pins List назначьте сигналу clk1 контакт Pin H16 и установите I/O standard равный 1.8 V. 
14. В окне All Pins list назначьте сигналу wren банк IOBANK_3 и установите I/O standard равный 1.8V. 
 
Ваше окно Pin Planner должно выглядеть подобным  образом. 

Шаг 2: Проверьте назначения контактам ввода/вывода. 
Сейчас, когда вы сделали основные назначения контактам ввода/вывода, можно проверить корректность этих назначений, без выполнения полной компиляции проекта. Таким способом можно быстро и легко найти ошибки при назначениях контактам ввода/вывода и исправить их. Для более строгой проверки назначений контактам ввода/вывода используйте утилиту I/O Assignment Analysis совместно с утилитой Live I/O Check.
1. В меню Processing главного окна Quartus II, в разделе Start выберите команду Start Analysis & Synthesis или нажмите кнопку , расположенную в панели инструментов главного окна Quartus II. Нажмите OK после завершения компиляции. 
Компилятор может отключить утилиту Live I/O Check и включить ее позже.  Если, после выполнения компиляции, утилита Live I/O Check не включилась, то ее можно повторно включить в окне Pin Planner. 
2. В меню Processing, в разделе Start выберите команду Start I/O Assignment Analysis или нажмите кнопку  в панели инструментов Pin Planner. Нажмите OK после завершения анализа. 
 
Результат анализа успешный? Проверьте сообщения в окне Messages или сообщения Fitter Messages в отчете компилятора Compilation Report. Эти сообщения показаны на рисунке выше. Утилита I/O Assignment Analysis обнаружила ошибки, о которых выдавалось сообщение утилитой Live I/O check в процессе выполнения назначений
3. Проанализируйте сообщения I/O Analysis Messages и определите причину ошибок. Раскройте собщения об ошибках для более подробного анализа причины того, почему все сигналы шины dataa не могут быть успешно размещены. 
Для определения причин невозможности размещения контактов ввода/вывода  необходимо: тщательный анализ сообщений об ошибках и наличие знаний об архитектуре семейства Cyclone II (ячеек ввода/вывода ПЛИС). Пункты 4-6 данного упражнения показывают, каким образом можно исправить ошибки. 
4. Вернитесь в Pin Planner и раскройте группы сигналов dataa и datab в окне Groups list. Если необходимо, сместите страницу, чтобы видеть колонку I/O Standard в окне Groups list или в окне All Pins list. 
Обратите внимание, вы назначили для входных шин dataa и datab банк I/O Bank 2, но при этом задали разные уровни напряжений VCCIO (1.8 & 2.5). ПЛИС Cyclone II, как и все микросхемы FPGA фирмы Altera, работают с единым уровнем напряжения  VCCIO для одного банка контактов ввода/вывода I/O bank. 
5. В окне Groups List измените назначение I/O standard для группы сигналов datab на 2.5 V. Убедитесь, что все сигналы шины datab имеют соответствующее назначение. 
Обратите внимание на изменения в окне Live I/O Check Status. 
6. Повторите анализ назначений с помощью утилиты I/O Assignment Analysis. Нажмите OK после завершения. 
Обратите внимание, как быстро и легко можно проверить назначения контактам ввода/вывода без выполнения полной компиляции проекта! 
7. Чтобы посмотреть, как трассировщик разместил назначенные контакты ввода/вывода, нажмите кнопку  в панели инструментов Pin Planner или в меню View выберите команду Show  Show Fitter Placements. Нажмите OK, чтобы отключить утилиту Live I/O check. 
Утилита Live I/O check должна быть отключена при просмотре результатов размещения. В окне статуса появится подтверждение об отключении. 
 
Вы увидете назначенные трассировщиком контакты, выделенные зеленым цветом в окне Pin Planner, как показано выше. 
Шаг 3: Сохраните назначенные контакты ввода/вывода с помощью утилиты Back-annotate. 
Этот шаг вы должны выполнить после проверки правильности назначений  выходных контактов, перед началом проектирования печатной платы. Теперь вы должны убедиться, что расположение назначенных контактов не изменилось при выполнении последующей компиляции.
1. В меню Assignments выберите команду Back-Annotate Assignments, чтобы открыть диалоговое окно Back-Annotate Assignments. Диалоговое окно может немного отличаться от приведенного ниже. 
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2. В разделе Assignments to back-annotate, отметьте опцию Pin & device assignments (обычно, установлена по умолчанию) как показано выше. Нажмите OK. 
 
Обратите внимание, все отмеченные зеленым цветом контакты ввода/вывода, теперь еще имеют красную штриховку. Это указывает на то, что контакты, которые были назначены трассировщиком, сейчас еще являются назначенными пользователем, и сохраняются как назначения в файле  .QSF. 

Шаг 4: Перенесите назначения контактов ввода/вывода в исходную версию проекта. 
Сейчас вы должны перенести назначения контактов ввода/вывода из текущей версии проекта в исходную (с которой работали раньше). Для этого, вначале, вы сохраните ваши назначения как  файл формата .CSV, а затем  импортируете их в исходную версию проекта - pipemult. 
1. Когда  окно Pin Planner активно, в меню File выберите команду Export. В открывшемся диалоговом окне Export задайте имя файла io_assignments.csv и нажмите Export. 

 
2. С помощью выпадающего меню в верхней части основного окна Quartus II измените активную версию проекта на pipemult. 
3. В меню Assignments выберите команду Import Assignments. 
 
4. В открывшемся диалоговом окне Import Assignments нажмите кнопку поиска в строке File name: и выберите файл io_assignments.csv. Отключите опцию Copy existing assignments into pipemult.qsf.bak before importing. Нажмите Open, затем OK.
5. Откройте окно  Pin Planner и проверьте правильность переноса назначений.  
 
Напоминаем, что отмеченные зеленым цветом контакты - результат размещения трассировщиком при предыдущей компиляции версии проекта pipemult. Окрашенные красным цветом контакты – импортированы из версии проекта  pipemult_lc. Окрашенные зеленым и заштрихованные красным цветом контакты - это совпадающие назначения для обеих версий проектов. После следующей компиляции отмеченные зеленым цветом контакты будут удалены. 
6. Отключите режим просмотра контактов, размещенных трассировщиком, с помощью кнопки , или соответствующей команды в меню View (раздел Show).

Шаг 5: Выберите другой тип микросхемы и выполните перенос назначений контактов ввода/вывода для неё.
Сейчас вы увидите, что произойдет с назначенными контактами при изменении их функционального назначения в случае переноса проекта в другую микросхему. Вы можете добавить другой тип микросхемы к проекту в любой момент, если хотите позже выполнить перенос. Утилита Pin Planner Pin Migration View позволяет отслеживать возможные проблемы, возникающие для назначенных контактов ввода/вывода при переносе проекта. 
1. Создайте новую версию проекта, используя базовую версию pipemult. Назовите её pipemult_migration. Назначьте её активной  с помощью диалогового окна Revisions или с помощью соответствующего меню в панели инструментов. Откройте окно Pin Planner. 
2. В окне Package View обратите внимание на контакт L12 и определите - назначен ли сигнал для этого контакта. Если контакт белого цвета – значит, назначения сигнала нет. Перейдите к следующему пункту. Если для этого контакта назначен какой-либо сигнал - перейдите к пункту 7. 
3. В окне All Pins list нажмите кнопку New Node , или опуститесь вниз списка контактов и нажмите левую кнопку мышки в ячейке <<new node>> в столбце Node Name. 
4. Задайте имя сигнала reserved_pin. 
5. Нажмите дважды левую кнопку мыши в ячейке Location рядом новым сигналом, и выберите PIN_L12 из выпадающего списка. 
6. В ячейке Reserved установите тип зарезервированного сигнала As input tri-stated. Нажмите левую кнопку мышки в любом свободном месте или нажмите клавишу tab, для сохранения созданного зарезервированного назначения.
В окне Package View вы увидите, что контакт L12 стал окрашенным в синий цвет. Это указывает на тот факт, что данный контакт зарезервирован. 
7. В меню View выберите команду Pin Migration View. 
 
Откроется окно Pin Migration View. В нем будет отражена информация о контактах только для заданного типа микросхемы, т.к. мы еще не выбрали микросхему для переноса проекта. 
8. Нажмите кнопку Device, чтобы открыть диалоговое окно Settings, категорию Device. 
9. Нажмите кнопку Migration Devices и установите опцию Show all speed grades. 
 
10. Выберите микросхему EP2C8F256I8 (убедитесь, что это именно так, т. к.  названия микросхем очень похожи) и нажмите дважды левую кнопку мышки на ней, или нажмите кнопку > для переноса её в список выбранных микросхем. Нажмите OK. Нажмите OK, чтобы закрыть диалоговое окно.
11. В окне Pin Migration View появилась информация о конактах для выбранной микросхемы. Установите опцию Show migration differences в нижней части окна, и посмотрите строку для контакта L12. 
 
Обратите внимание, данный контакт перенесен из банка 4 старой микросхемы в банк 3 для новой микросхемы. Поэтому, ячейка Migration Result остается незаполненной, указывая на то, что сигнал для этого контакта не может быть перенесен на тот же контакт в другой микросхеме. Давайте проверим это с помощью утилиты I/O Assignment Analysis. 
12. Закройте окно Pin MigrationView. В меню Processing, в разделе Start выберите команду Start I/O Assignment Analysis или нажмите кнопку  в панели инструментов Pin Planner. Нажмите OK после завершения анализа. 
Что же получилось? Утилита I/O Assignment Analysis выдала сообщение об ошибках потому, что  назначение сигнала контакту L12 не может быть выполнено одновременно для двух выбранных типов микросхем.  Если сейчас внимательно посмотреть на контакт L12 в окне Package View, вы увидите знак X на данном контакте, обозначающий NC или  no connect. Даже в том случае, когда сигнал может быть назначен этому контакту в одной микросхеме, утилита Pin Planner препятствует вводу назначения, т.к. в  микросхеме EP2C8F256I8 этот контакт имеет другое функциональное назначение. 
13. Перейдите к версии проекта pipemult и закройте окно Pin Planner. 
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При проектировании цифровых устройств может потребоваться элемент, отсутствующий в библиотеке моделей базовых элементов системы. В этом случае требуемый элемент можно создать на основе базовых элементов системы, а затем оформить его в виде подсхемы (макроэлемента) с прорисовкой условного графического обозначения (УГО). C этой задачей призван справляться Символьный редактор позволяет создавать и редактировать УГО (символ). Символьный файл имеет то же имя, что и проект, с расширением .bsf


Создание макроэлемента

Под макроэлементом понимается определенным образом оформленная и записанная в рабочую библиотеку проекта схема, которой поставлен в соответствие рисунок УГО. Макроэлементы целесообразно использовать для оформления функционально законченных частей сложного проекта. Само собой разумеется, что оформление схемы в форме макроэлемента выполняется после ее отладки.
1) Откомпилируйте проект, нажав кнопку Start Compilation  на верхней горизонтальной панели инструментов, или, выбрав пункт File->Processing->Start Compilation в главном меню);
2) Выполните команду  File-> Create/Update->Create Symbol Files from Current File из главного меню. Появится сообщение о  создании символа (УГО) – файл будет включен в вашу библиотеку (top .BSF), автоматически будет сформирован рисунок УГО.
Выбор подсхемы из библиотеки
Созданный системой рисунок УГО вы можете в дальнейшем использовать в своих схемах, а также при создании более сложных макроэлементов. Нажмите на панели инструментов окна редактора схем кнопку «Symbol Tool» . Появится диалоговое окно Symbol выбора модели элемента (рис. 10). В этом окне найдите и выделите имя макроэлемента. Затем выберите в поле рисования требуемую позицию для размещения УГО макроэлемента и нажмите левую клавишу мыши. Появится рисунок УГО выбранного макроэлемента.

 (
Рисунок УГО макроэлемента
)						
Рис. 10. Выбор макроэлемента
Редактирование УГО макроэлемента
Созданный системой рисунок УГО можно изменить по своему усмотрению.
Для редактирования УГО макроэлемента необходимо выполнить следующие действия:
1. Выберите в папке проекта редактируемый макроэлемент (<имя_файла>.BSF) (рис. 11). 

              Рис. 11. УГО макроэлемента
2.  При помощи графических элементов панели инструментов отредактируйте изображение УГО макроэлемента (рис. 12).

             Рис. 12. Отредактированный рисунок УГО макроэлемента
3. Сохраните введенные изменения в УГО макроэлемента.
Чтобы увидеть логическую структуру макроэлемента, необходимо дважды щелкнуть мышью по УГО элемента.
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После того как схематическое описание проекта введено в САПР Quartus II оно обрабатывается множеством специализированных инструментов (Tools). Вначале производится синтез проекта для перевода проекта из схематического описания в логические выражения. Затем в процессе, называемом «составление технологической карты» (technology mapping) определяется, как каждое логическое выражение будет представлено на логических вентилях кристалла.

Использование Компилятора (Compiler):

Специализированные  инструменты доступные в Quartus II делятся на несколько модулей. Выполните команду Tools->Compiler Tool  для просмотра пяти основных модулей (рис. 13).


Рис. 13 Инструмент Compiler Tool  

-	Модуль «Analysis & Synthesis» (Анализ и Синтез) обеспечивает функцию синтеза в САПР Quartus II. Он производит схему из логических элементов, в которой каждый элемент может быть отображен на требуемый кристалл.
-	Модуль «Fitter» (Размещение и Трассировка) определяет конкретное место на кристалле для каждого логического элемента. 
-	Модуль «Assembler» (Сборщик) генерирует конфигурационные  файлы для прошивки ПЛИС. 
-	Модуль «Timing Analyzer» (Временной Анализатор) позволяет разработчику анализировать работу проектируемой логической цепи после того, как она была синтезирована и оптимизирована компилятором. Разработчик может исследовать все пути прохождения сигналов в проектируемой логической цепи и определить критические задержки в цепях.
-	Модуль «EDA Netlist Writer» - подготавливает список сетей для других САПР. 
Все эти модули управляются программой-приложением, называемой компилятором. Компиляция предусматривает синтез проекта, т. е. построение базы данных и оценку быстродействия объекта компиляции. 

В Quartus II предусмотрено несколько способов компиляции проекта. Доступ ко всем режимам компиляции осуществляется через меню File->Processing->Start (рис.14). Компиляцию можно остановить в любой момент, просто нажав кнопку «Stop Processing» на главной панели инструментов.

 (
кнопка «
Stop
 
Processing
»
)

       Рис.  14 Меню File->Processing->Start

Перед осуществлением компиляции, если еще не выбран тип кристалла, то его необходимо выбрать. Для этого выберем  пункт Assignments(Назначения)->Device…               В открывшемся окне в строке Family выберем семейство Cyclone, а в окне Available Devices выберем нашу микросхему – EP1C3T144C8. Нажатием кнопки OK подтвердим выбор кристалла.
Существует такое понятие, как объект компиляции «Focus Points». Это такой компонент в иерархии описаний проекта, который будет компилироваться так, как если бы он был компонентом верхнего уровня в иерархии описаний. Файл верхнего уровня в иерархии описания проекта (Top-level entity) является объектом компиляции по умолчанию (рис. 15).

Рис. 15 Пример назначения Focus Points

 Для запуска процесса компиляции выберем пункт Start Compilation из меню Processing или нажмем Ctrl+L. Подтвердив сохранение текущего файла, ожидаем окончания процесса компиляции. По окончании компиляции появляется окно Compilation Report с сообщениями о результатах компиляции, количестве ошибок и предупреждений. 
Индикация процесса компиляции осуществляется следующим образом (рис. 16): 
- опустошаются и переворачиваются песочные часы, что указывает на активность компилятора, процент завершения компиляции постепенно увеличивается до 100% и время, прошедшее с начала компиляции; 
-  один за другим высвечиваются прямоугольники модулей компилятора, по мере того как компилятор завершает каждый этап обработки; 
- при обнаружении в процессе компиляции каких-либо ошибок или возможных проблем автоматически открывается окно обработчика сообщений, в котором отображается сообщения об ошибках и информационные сообщения, а также дается справка по исправлению ошибки. Кроме того, можно определить источники сообщений в файлах проекта или в его редакторе назначений. 


 (
Окно отчета появляется автоматически   после окончания     компиляции. Оно содержит:
 сводную информацию (поле 
Summary
)
 детальную информацию, разбитую по отдельным разделам.
 
модули компилятора
 
окно обработчика сообщений
)
Рис 16  Окно Compilation Report

Возможно переключение режима отображения результатов в режим измерительных приборов. Для этого необходимо нажать правую кнопку мыши в поле Summary (рис. 16) и выбрать пункт Gauge Summary (Измерительные Приборы - Итог). Любой датчик можно переключить в режим отображения результатов в процентном соотношении (Percent) (рис. 17).

Рис. 17 Режим Gauge Summary
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Создание временных диаграмм (временное моделирование) в САПР QuartusII (Waveform entry) осуществляется одним из следующих способов:
· .vwf (vector waveform file) – файл редактора временных диаграмм пакета Quartus II
· .vec (vector file) – векторный файл, использовавшийся в пакете MAX+PLUS II, поддерживается для обратной совместимости пакетов
· .tbl (table file) – табуляционный файл, используемый для импортирования временных диаграмм, созданных в пакете MAX+PLUS II (.scf), в пакет Quartus II
· Создание тестовых воздействий на языке Tcl/TK 
· Использование систем моделирования сторонних производителей (Modelsim, ActiveHDL и др.) 
· Создание тестов на языках Verilog и VHDL.
Перед началом симуляции требуется задать файл временных диаграмм – File->New->Other Files->Vector Waveform File. Откроется окно моделирования (рис. 18).


	Рис. 18 Окно моделирования схемы
Сохраните файл под именем top.vwf.  Задайте желаемый временной интервал моделирования равным 1 мкс - Edit->End Time и загрузите список входов и выходов схемы, для которых необходимо провести симуляцию. Для этого дважды щелкните в левом свободном поле (рис. 18) или выберем команду Edit->Insert Node or Bus в главном меню. Появляется окно Insert Node or Bus  (рис. 19), в котором нажимаем кнопку Node Finder…


	Рис. 19 Окно Insert Node Bus  

В окне Node Finder в поле Filter (Фильтр) устанавливаем Pins:all (Выводы: все) и нажимаем List (Отобразить) и переводим найденные входы и выходы в выбранные (т. е из левой части в правую). После чего последовательно нажимаем ОК до выхода. Результат приведен на рис. 20.


Рис. 20 Список всех входов и выходов

Выделяя необходимые сигналы на требуемом интервале времени, при помощи панели инструментов (рис. 21), задаем на данном интервале необходимые логические уровни из меню сигналов, расположенного непосредственно над выделяемой областью. Для навигации в окне симуляции удобно пользоваться комбинациями горячих клавиш Ctrl+Shift+Space – для уменьшения масштаба и Ctrl+Space – для увеличения (или удерживая клавишу Ctrl крутить колесико мыши).
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Рис. 21 Панель инструментов для задания векторов сигнала 




Рис. 22 Окно симуляции после задания векторов сигналов
После задания всех уровней сигналов запускаем симуляцию. Для запуска системы моделирования могут использоваться следующие команды:
· Processing =>Start Compilation & Simulation 	
· Processing => Start Simulation
· Иконка  на главной панели инструментов.
Просмотреть результат моделирования в виде временной диаграммы можно, если в разделе Simulator выбрать Simulation Waveforms (рис. 23).
 (
Отчет о результатах моделирования
) (
Обобщенные результаты
) (
Simulation
 
Waveforms
)

Рис. 23 Отчет о результатах моделирования

Отметим, что САПР Quartus II позволяет проводить сравнение двух временных диаграмм. Для этого, находясь в режиме просмотра файла временных диаграмм, нужно выбрать в меню View пункт Compare to Waveforms in File… и указать тот файл временных диаграмм, с которым нужно произвести сравнение.



[bookmark: _Toc351203212]Практическая работа 7.  FloorРlan Editor размещение схемы на кристалле

		Для размещения схемы, созданной в системе Quartus II, непосредственно на кристалле необходимо задать физическое отображение (иначе - назначение, распределение, задание) созданных элементов ввода - вывода (input/output) на реальные выводы конкретной ПЛИС. Эту задачу призван выполнять Редактор Назначений (Assignment Editor). Для доступа к нему выполните команду Assignments->Assignment Editor или нажмите Ctrl+Shift+A. 
		Этот редактор позволяет отобразить все выводы ПЛИС и их свойства, а также задать для каждого вывода стандарт ввода – вывода. С помощью этого редактора вы можете сортировать и фильтровать назначения, основанные на имени цепи или типе назначения.    
Окно Редактора Assignment Editor состоит из четырех вкладок – Category (Вид), Node Filter (Фильтр Цепей), Edit (Редактирование), Information (Информация) и главной таблицы (рис. 24).
Вкладка Category содержит список всех назначений, доступных для данной ПЛИС. Вы можете использовать эту вкладку для того, чтобы выбрать один тип назначений и отфильтровать все остальные.
Вкладка Node Filter отображает все назначения только для цепей, указанных фильтром. Галочка «Show assignments for specific nodes» должна быть включена.
Вкладка Edit позволяет вводить и изменять значения в таблицу назначений.
Вкладка Information отображает справочную информацию о конкретной ячейке таблицы.


 (
Номер назначения
)

   					     Рис. 24 Редактор Assignment Editor

	Данный редактор поддерживает Систему динамической проверки назначений (Dynamic Checking of Assignments) (рис. 25), которая обеспечивает:
	- проверку допустимости назначений в процессе их ввода;
	- отображение цветом статуса назначения.

Если назначение выделено:
	-  коричневым цветом – это значит, что назначение неполное,
	-  черным – назначение активно,
	-  зеленым – новое назначение может быть задано,
	-  серым  – назначение отключено,
	-  красным –  назначение содержит ошибку,
	- желтым – назначение содержит предупреждения  (warnings), например, из-за неизвестного имени цепи.

Рис. 25 Проверка назначений

Все заданные назначения хранятся в файле <имя_файла>.pin. Файл будет автоматически создан пакетом Quartus II при компиляции. В рабочей папке проекта может быть несколько файлов <имя_файла>.pin.
	

Теперь рассмотрим возможности FloorРlan Editor (Редактора Общей Топологической Структуры ПЛИС или Поуровневого Планировщика), с помощью которого пользователь назначает ресурсы физических устройств и просматривает результаты разветвлений и монтажа, сделанных компилятором.
В окне поуровневого планировщика могут быть представлены два типа изображения:
1) Chip Editor (Редактор кристалла) показывает все соединения устройства в сборке и их функции;
2) Timing Closure Floorplan представляет собой проект, размещенный внутри кристалла - показывает внутреннюю структуру устройства, в том числе все логические блоки (LAB) и отдельные логические элементы или макроячейки.
 	В окне Compilation Report выберем из меню Fitter пункт Floorplan View или выберем Assignments->Timing Closure Floorplan. Окно Floorplan View изображено на рис. 26. На этом рисунке представлено укрупненное внутреннее содержимое выбранного нами кристалла с назначенными выводами. Внутреннее содержимое кристалла типа FPGA представляет собой совокупность логических блоков, каждый из которых содержит по 10 логических элементов.
 (
 Легенда 
 
) (
Логический элемент
 
) (
Логический блок 
) (
Show detail
(показать детально) 
)
Рис. 26  Floorplan Editor для кристалла типа FPGA 

Окно Floorplan View, изображенное на рис. 27, соответствует проекту, реализуемому на базе ПЛИС типа CPLD (МАХ 3000А). Представлены макроячейки этой ПЛИС, которые, как известно, организованы в логические блоки по 16 в каждом. 
Вместо того, чтобы отображать логические блоки, бывает полезно взглянуть на то, где конкретно расположены нужныевыводы ПЛИС. Для этого перейдите (View->Package Top) к виду сверху или снизу (View->Package Bottom).


Рис. 27  Floorplan Editor для кристалла типа CPLD
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1 Цель работы: Целью работы является изучение принципов действия комбинационных схем: дешифратора, шифратора, преобразователя кода для семисегментного индикатора, мультиплексора, сумматора. 
2 Краткие теоретические сведения 
2.1 Дешифратор (декодер)
Дешифратор (декодер) служит для преобразования n-разрядного позиционного двоичного кода в единичный выходной сигнал на одном из 2n выходов. При каждой входной комбинации сигналов на одном из выходов появляется 1 . Таким образом, по единичному сигналу на одном из выходов можно судить о входной кодовой комбинации. Таблица истинности для декодера с двумя входами изображена в таблице 2.1. 
Таблица 2.1 – Таблица истинности двухразрядного дешифратора 
	x1
	x2
	y0
	y1
	y2
	y3

	0
	0
	1
	0
	0
	0

	0
	1
	0
	1
	0
	0

	1
	0
	0
	0
	1
	0

	1
	1
	0
	0
	0
	1


Для построения схемы декодера по таблице истинности воспользуемся методикой, изложенной в лабораторной работе №1. Например, устройство должно иметь 4 выхода. Для каждого выхода записываем логическое выражение. На основе СДНФ: 
y0 = x1·x2
y1 = x1·x2
y2 = x1·x2
y3 = x1·x2

По этой системе выражений несложно построить схему требуемого дешифратора (рисунок 2.1). 

Рисунок 2.1 – Схема дешифратора
Условное графическое обозначение такого дешифратора изображено на рисунке 2.2. 

Рисунок 2.2 – Условное графическое обозначение дешифратора
2.2 Шифратор (кодер)
Шифратор выполняет функцию, обратную декодеру (дешифратору), то есть преобразует непозиционный (унитарный) двоичный 2n разрядный код в n разрядный позиционный код. При подаче на один из входов единичного сигнала на выходе формируется соответствующий двоичный код. Составим таблицу истинности шифратора при n = 2. 
Таблица 2.2 – Таблица истинности шифратора при n = 2 
	x1
	x2
	x3
	x4
	y1
	y0

	1
	0
	0
	0
	0
	0

	0
	1
	0
	0
	0
	1

	0
	0
	1
	0
	1
	0

	0
	0
	0
	1
	1
	1


Синтезируем шифратор. Для этого запишем систему его собственных функций: 
y1 = x1 · x2 · x3 · x4 + x1 · x2 · x3 ·x4
y0 = x1 · x2 · x3 · x4 + x1 · x2 · x3 ·x4


Рисунок 2.3 – Схема шифратора

Рисунок 2.4 – Условное графическое обозначение шифратора
2.3 Преобразователь кода для семи сегментного индикатора
Наиболее широко преобразователи кодов известны применительно к цифровым индикаторам. Например, преобразователь 4-х разрядного позиционного двоичного кода в десятичные цифры. Имеется семи сегментный индикатор и с его помощью требуется высветить десять цифр. 

Рисунок 2.5 – Семи сегментный индикатор
Очевидно, что двоичный код должен иметь не менее 4 - х разрядов (2^4 = 16, что больше 10). Составим таблицу истинности работы такого преобразователя. 
Таблица 2.3 – Таблица истинности преобразователя 
	Цифра
	Двоичный код 8-4-2-1 
	a
	б
	в
	г
	д
	е
	ж

	0
	0
	0
	0
	0
	1
	1
	1
	1
	1
	1
	0

	1
	0
	0
	0
	1
	0
	1
	1
	0
	0
	0
	0

	2
	0
	0
	1
	0
	1
	1
	0
	1
	1
	0
	1

	3
	0
	0
	1
	1
	1
	1
	1
	1
	0
	0
	1

	4
	0
	1
	0
	0
	0
	1
	1
	0
	0
	1
	1

	5
	0
	1
	0
	1
	1
	0
	1
	1
	0
	1
	1

	6
	0
	1
	1
	0
	1
	0
	1
	1
	1
	1
	1

	7
	0
	1
	1
	1
	1
	1
	1
	0
	0
	0
	0

	8
	1
	0
	0
	0
	1
	1
	1
	1
	1
	1
	1

	9
	1
	0
	0
	1
	1
	1
	1
	1
	0
	1
	1


По ТИ несложно составить систему собственных функций для всех выходов, т.е. СДНФ, минимизировать её и составить принципиальную схему. 

Рисунок 2.6 – Условное графическое обозначение преобразователя кода
2.4 Мультиплексор Мультиплексор – устройство, которое позволяет коммутировать один из 2^n информационных входов X на один выход Y под действием n управляющих (адресных) сигналов. На рисунке. 2.7 изображена упрощенная функциональная схема мультиплексора на идеализированных электронных ключах. 

Рисунок 2.7 – Схема мультиплексора на идеализированных электронных ключах
В цифровых схемах требуется управлять ключами при помощи логических уровней. Поэтому желательно подобрать устройство, которое могло бы выполнять функции электронного ключа с управлением цифровым сигналом. Попробуем «заставить» работать в качестве электронного ключа уже знакомые нам логические элементы. Рассмотрим ТИ логического элемента «И». При этом один из входов логического элемента «И» будем рассматривать как информационный вход электронного ключа, а другой вход – как управляющий. Так как оба входа логического элемента «И» эквивалентны, то не важно какой из них будет управляющим входом. Пусть вход X будет управляющим, а Y – информационным. Для простоты рассуждений, разделим ТИ на две части в зависимости от уровня логического сигнала на управляющем входе X. 
Таблица 2.4 – Таблица истинности 
	y
	x
	Out

	0
0
	0
1
	0
0

	1
1
	0
1
	0
1


По таблице истинности отчётливо видно, что если на управляющий вход X подан нулевой логический уровень, сигнал, поданный на вход Y, на выход Out не проходит. При подаче на управляющий вход X логической единицы, сигнал, поступающий на вход Y, появляется на выходе Out. Это означает, что логический элемент «И» можно использовать в качестве электронного ключа. При этом не важно, какой из входов элемента "И" будет использоваться в качестве управляющего входа, а какой – в качестве информационного. Остается только объединить выходы элементов «И» на один общий выход. Это делается при помощи логического элемента «ИЛИ» точно так же как и при построении схемы по произвольной таблице истинности. Получившийся вариант схемы коммутатора с управлением логическими уровнями приведён на рисунке 2.8. 

Рисунок 2.8 – Принципиальная схема мультиплексора, выполненная на логических элементах
В схемах, приведенных на рисунках 2.7 и 2.8, можно одновременно включать несколько входов на один выход. Однако обычно это приводит к непредсказуемым последствиям. Кроме того, для управления таким коммутатором требуется много входов, поэтому в состав мультиплексора обычно включают двоичный дешифратор, как показано на рисунке 2.9. Такая схема позволяет управлять переключением информационных входов мультиплексора при помощи двоичных кодов, подаваемых на его управляющие входы. Количество информационных входов в таких схемах выбирают кратным степени числа два. 

Рисунок 2.9 – Принципиальная схема мультиплексора, управляемого двоичным кодом
Условное графическое обозначение 4–х входового мультиплексора с управлением двоичным кодом приведено на рисунке 2.10. Входы A0 и A1 являются управляющими входами мультиплексора, определяющими адрес информационного входного сигнала, который будет соединён с выходным выводом мультиплексора Y. Информационные входные сигналы обозначены: X0, X1, X2 и X3. 

Рисунок 2.10 – Условное графическое обозначение 4-х входового мультиплексора
В условном графическом обозначении названия информационных входов A, B, C и D заменены названиями X0, X1, X2 и X3, а название выхода Out заменено на название Y. Такое обозначение входов и выходов мультиплексора более распространено в отечественной литературе. Адресные входы обозначены как A0 и A1.
2.5 Сумматор
Сумматор – узел компьютера, предназначенный для сложения двоичных чисел. Построение двоичных сумматоров обычно начинается с сумматора по модулю 2.
Сумматор по модулю 2 Схема сумматора по модулю 2 совпадает со схемой исключающее «ИЛИ». 
Таблица 2.5 – Таблица истинности сумматора по модулю 2 
	x1
	x2
	y

	0
	0
	0

	0
	1
	1

	1
	0
	1

	1
	1
	0


Логическое выражение, описывающее сумматор по модулю 2: 
y = x1 · x2 + x1 · x2 

Рисунок 2.11 – Условное графическое обозначение сумматора по модулю 2
На основе логического уравнения, описывающего этот элемент можно синтезировать схему: 

Рисунок 2.12 – Схема сумматора по модулю 2
Сумматор по модулю 2 выполняет суммирование без учёта переноса. В обычном двоичном сумматоре требуется учитывать перенос, поэтому требуются схемы, позволяющие формировать перенос в следующий двоичный разряд. Таблица истинности такой схемы, называемой полусумматором, приведена в таблице 2.6. 
Таблица 2.6 – Таблица истинности полусумматора 
	A
	B
	S
	P0

	0
	0
	0
	0

	0
	1
	1
	0

	1
	0
	1
	0

	1
	1
	0
	1



Здесь A и B – слагаемые;
S – сумма;
P0 – перенос в старший разряд (выход переноса Pout).
Запишем систему собственных функций для полусумматора: 
S = A · B + A · B 

P0 = A · B 

Рисунок 2.13 – Принципиальная схема, реализующая таблицу истинности полусумматора

Рисунок 2.14 – Изображение полусумматора на схемах
Полный сумматор.
Схема полусумматора формирует перенос в старший разряд, но не может учитывать перенос из младшего разряда. При сложении многоразрядных двоичных чисел необходимо складывать три цифры в каждом разряде – 2 слагаемых и единицу переноса из предыдущего разряда PI. 
Таблица 2.7 – Таблица истинности полного сумматора 
	PI
	A
	B
	S
	PO

	0
	0
	0
	0
	0

	0
	0
	1
	1
	0

	0
	1
	0
	1
	0

	0
	1
	1
	0
	1

	1
	0
	0
	1
	0

	1
	0
	1
	0
	1

	1
	1
	0
	0
	1

	1
	1
	1
	1
	1



PI – вход 1 переноса из предыдущего разряда,
PO – выход 1 переноса в старший разряд.
На основании таблицы истинности запишем систему собственных функций для каждого выхода: 
S = A · B · PI + A · B · PI + A · B · PI + A · B · PI 
PO = A · B · PI + A · B · PI + A · B · PI + A · B · PI 
В результате получим схему полного сумматора (рисунок 2.15). 

Рисунок 2.15 – Принципиальная схема, реализующая таблицу истинности полного двоичного одноразрядного сумматора

[bookmark: BM3]Рисунок 2.16 – Изображение полного двоичного одноразрядного сумматора на схемах

3 Задание к работе 
3.1 Исследовать принцип работы дешифратора 2 x 4 
Сконфигурировать ПЛИС в соответствии с рисунком 3.1. Подключить к входам X0 и X1 переключатели S7 и S8, а к выходам Y0, Y1, Y2, Y3 светодиодные индикаторы LED5, LED6, LED7, LED8. Для этого подключить входы и выходы дешифратора к соответствующим ножкам ПЛИС. 

Рисунок 3.1 – Схема дешифратора
Подавая все возможные комбинации логических уровней на входы X0, X1 с помощью ключей S7, S8 и наблюдая за состояниями светодиодных индикаторов LED5, LED6, LED7, LED8, заполните таблицу истинности дешифратора. 
Таблица 3.1 – Таблица дешифратора 
	x1
	x2
	y0
	y1
	y2
	y3

	0
	0
	 
	 
	 
	 

	0
	1
	 
	 
	 
	 

	1
	0
	 
	 
	 
	 

	1
	1
	 
	 
	 
	 


3.2 Исследовать принцип работы шифратора 4x2
Сконфигурировать ПЛИС в соответствии с рисунком 3.2. 

Рисунок 3.2 – Схема шифратора 4x2
Подключить к входам X1, X2, X3, X4 переключатели S8, S7, S6, S5, а к выходам Y0, Y1 светодиодные индикаторы LED8, LED7. Для этого подключить входы и выходы дешифратора к соответствующим ножкам ПЛИС. Подавая все возможные комбинации логических уровней на входы X1, X2, X3, X4 с помощью ключей S8, S7, S6, S5 и наблюдая за состояниями светодиодных индикаторов LED7, LED8, заполните таблицу истинности шифратора. 
Таблица 3.2 – Таблица истинности шифратора 
	x1
	x2
	x3
	x4
	y1
	y0

	1
	0
	0
	0
	 
	 

	0
	1
	0
	0
	 
	 

	0
	0
	1
	0
	 
	 

	0
	0
	0
	1
	 
	 


3.3 Исследовать работу преобразователя кода для семисегментного индикатора.
Составить таблицу истинности преобразователя кода (таблица. 3.3).
Собрать схему, изображенную на рисунке 3.3.
Таблица 3.3 – Таблица истинности преобразователя 
	x3
	x2
	x1
	x0
	A
	B
	C
	D
	E
	F
	G

	0
	0
	0
	0
	 
	 
	 
	 
	 
	 
	 

	0
	0
	0
	1
	 
	 
	 
	 
	 
	 
	 

	0
	0
	1
	0
	 
	 
	 
	 
	 
	 
	 

	0
	0
	1
	1
	 
	 
	 
	 
	 
	 
	 

	0
	1
	0
	0
	 
	 
	 
	 
	 
	 
	 

	0
	1
	0
	1
	 
	 
	 
	 
	 
	 
	 

	0
	1
	1
	0
	 
	 
	 
	 
	 
	 
	 

	0
	1
	1
	1
	 
	 
	 
	 
	 
	 
	 

	1
	0
	0
	0
	 
	 
	 
	 
	 
	 
	 

	1
	0
	0
	1
	 
	 
	 
	 
	 
	 
	 




Рисунок 3.3 – Схема преобразователя кода для семисегментного индикатора
Подавая с помощью ключей S8, S7, S6, S5 различные кодовые комбинации на входы X0, X1, X2, X3 определить цифры, высвечиваемые на индикаторе. По результатам эксперимента заполнить таблицу 3.4. 
Таблица 3.4 – Таблица, описывающая работу преобразователя кода 
для семи сегментного индикатора 
	x3
	x2
	x1
	x0
	Показание индикатора

	0
	0
	0
	0
	 

	0
	0
	0
	1
	 

	0
	0
	1
	0
	 

	0
	0
	1
	1
	 

	0
	1
	0
	0
	 

	0
	1
	0
	1
	 

	0
	1
	1
	0
	 

	0
	1
	1
	1
	 

	1
	0
	0
	0
	 

	1
	0
	0
	1
	 


3.4 Исследовать работу мультиплексора 4x1
Сконфигурировать ПЛИС в соответствии с рисунком 3.4. 

Рисунок 3.4 – Схема мультиплексора 4x1
Поочередно устанавливая все возможные кодовые комбинации на адресных входах A и B, определите номера коммутируемых каналов. Номер коммутируемого канала определяется путем поочерёдного подключения к входам X0, X2, X3, X4 уровня логической единицы и наблюдения за выходом Y. Заполните таблицу 3.5. 
Таблица 3.5 – Таблица, описывающая работу мультиплексора 
	B
	A
	Номер коммутируемого канала

	0
	0
	 

	0
	1
	 

	1
	0
	 

	1
	1
	 


3.5 Исследовать схему сумматора
Сконфигурировать ПЛИС в соответствии с рисунком 3.5.
Здесь Pin, Pout соответственно вход и выход единицы переноса, A и B – слагаемые, S – сумма. 

Рисунок 3.5 – Схема сумматора
Заполнить таблицу истинности сумматора (таблица 3.6). 
Таблица 2.7 – Таблица истинности полного сумматора 
	Pin
	B
	A
	Pout

	0
	0
	0
	 

	0
	0
	1
	 

	0
	1
	0
	 

	0
	1
	1
	 

	1
	0
	0
	 

	1
	0
	1
	 

	1
	1
	0
	 

	1
	1
	1
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4 Содержание отчета 
4.1 Цель работы. 
4.2 Схемы исследования дешифратора, шифратора, преобразователя кода для семисегментного индикатора, мультиплексора, сумматора. 
4.3 Таблицы истинности для каждой схемы. 
4.4 Выводы по каждому заданию. 
5 Контрольные вопросы 
5.1 Принцип работы дешифратора? 
5.2 Как синтезировать дешифратор с произвольной разрядностью? 
5.3 Как работает шифратор? 
5.4 Изобразите таблицу истинности шифратора. 
5.5 Как работает преобразователь кода для семи сегментного индикатора? 
5.6 Как устроен семи сегментный индикатор? 
5.7 Как работает мультиплексор? 

5.8 Как в лабораторной работе проводилось исследование мультиплексора? 
5.9 Как работает сумматор? 
5.10 Изобразите таблицу истинности шифратора. 

5.11 Что такое единица переноса? 


[bookmark: _Toc351203214]Практическая работа 9. Исследование регистров

1 Цель работы: Целью работы является изучение принципа работы схем триггерных регистров и приобретение практических навыков в выполнении микроопераций на регистрах в статическом режиме. 
2 Краткие теоретические сведения
Регистры предназначены для хранения и преобразования многоразрядных двоичных чисел. Для запоминания отдельных разрядов числа могут применяться триггеры различных типов. Одиночный триггер можно считать одноразрядным регистром.
Занесение информации в регистр называется операцией записи. Операция выдачи информации из регистра – считывание.
Перед записью информации в регистр, его необходимо обнулить.
Классификация регистров: 

1 по способу ввода/вывода информации:
1. параллельные (регистры хранения) – информация вводится и выводится одновременно по всем разрядам; 
1. последовательные (регистры сдвига) – информация бит за битом «проталкивается» через регистр и выводится также последовательно; 
1. комбинированные – параллельный ввод и последовательный вывод (и наоборот). 
2 по способу представления информации: 
1. однофазные – информация представляется в прямом или обратном (инверсном) виде; 
1. парафазные – информация представляется и в прямом, и в обратном виде. 
[bookmark: p_rg]2.1 Параллельный регистр 
Параллельные регистры осуществляют прием и выдачу информации в параллельном коде, а это значит, что для передачи каждого разряда используется отдельная линия. 
Для записи информации в регистр на его входных выводах (D0-D3) нужно установить логические уровни, после чего на вход синхронизации (C) подать разрешающий импульс — логическую единицу. После этого на выходах Q0-Q3 появится записанное слово. Регистры запоминают входные сигналы только в момент времени, определяемый сигналом синхронизации. 

Рисунок 2.1 – Условно-графическое обозначение параллельного регистра

Рисунок 2.2 – Схема параллельного регистра
2.1 Последовательные регистры
Кроме параллельного соединения триггеров для построения регистров используются последовательное соединение этих элементов.
Последовательный регистр (регистр сдвига) обычно служит для преобразования последовательного кода в параллельный и наоборот. Применение последовательного кода связано с необходимостью передачи большого количества двоичной информации по ограниченному количеству соединительных линий. При параллельной передаче разрядов требуется большое количество соединительных проводников. Если двоичные разряды последовательно бит за битом передавать по одному проводнику, то можно значительно сократить размеры соединительных линий на плате (и размеры корпусов микросхем). 
Принципиальная схема последовательного регистра, собранного на основе D-триггеров и позволяющего осуществить преобразование последовательного кода в параллельный, приведена на рисунке 2.3.
Рассмотрим работу этого регистра.
Можно предположить, что в начале все триггеры регистра находятся в состоянии логического нуля, т.е. Q0=0, Q1=0, Q2=0, Q3=0. Если на входе D-триггера Т1 имеет место логический 0, то поступление синхроимпульсов на входы «С» триггеров не меняет их состояния. 

Рисунок 2.3 – Схема последовательного регистра
Как следует из рисунка 2.3, синхроимпульсы поступают на соответствующие входы всех триггеров регистра одновременно и записывают в них то, что имеет место на их информационных входах. На информационных входах триггеров Т2, Т3, Т4 – уровни логического «0», т.к. информационные входы последующих триггеров соединены с выходами предыдущих триггеров, находящихся в состоянии логического «0», а на вход «D» первого триггера, по условию примера, подается «0» из внешнего источника информации. При подаче на вход «D» первого триггера «1», с приходом первого синхроимпульса, в этот триггер запишется «1», а в остальные триггеры – «0», т.к. к моменту поступления фронта синхроимпульса на выходе триггера Т1 ещё присутствовал логический «0». Таким образом, в триггер Т1 записывается та информация (тот бит), которая была на его входе «D в момент поступления фронта синхроимпульса и т.д. 
При поступлении второго синхроимпульса логическая «1» с выхода первого триггера, запишется во второй триггер, и в результате происходит сдвиг первоначально записанной «1» с триггера Т1 в триггер Т2, из триггера Т2 в триггер Т3 и т.д. Таким образом, производится последовательный сдвиг поступающей на вход регистра информации (в последовательном коде) на один разряд вправо в каждом такте синхроимпульсов. 
После поступления четырёх синхроимпульсов регистр оказывается полностью заполненным разрядами числа, вводимого через последовательный ввод «D». В течение следующих четырёх синхроимпульсов производится последовательный поразрядный вывод из регистра записанного числа, после чего регистр оказывается полностью очищенным (регистр окажется полностью очищенным только при условии подачи на его вход уровня «0» в режиме вывода записанного числа). 

Рисунок 2.4 – Временные диаграммы, поясняющие работу регистра сдвига
3 Задание к работе 
3.1 Исследовать параллельный регистр
Сконфигурировать ПЛИС в соответствии с рисунком 3.1. 

Рисунок 3.1 – Схема 4-х битного параллельного регистра
Записать целые десятичные числа от 0 до 15 в двоичной системе счисления в регистр и считать их. Заполнить таблицу 3.1. 
Таблица 3.1 – Коды, записанные в параллельный регистр 
	Записываемое десятичное число
	Считанное из регистра двоичное число

	0
	 

	1
	 

	...
	 

	15
	 


3.2 Исследовать последовательно-параллельный регистр
Сконфигурировать ПЛИС в соответствии с рисунком 3.2. 

Рисунок 3.2 – Схема последовательно-параллельного регистра
Элемент 74164 – это последовательно-параллельный регистр. 

Записать нечётное число в интервале от 32 до 56 в последовательном коде, поразрядно продвигая его влево путём нажатия кнопки Button. Записать результат в отчёт. 
3.3 Исследовать параллельно-последовательный регистр
Сконфигурировать ПЛИС в соответствии с рисунком 3.3. 

Рисунок 3.3 – Схема параллельно-последовательного регистра
Элемент 74166 представляет собой параллельно-последовательный регистр.
Чтобы записать на входе число необходимо установить на входе STLD логический 0 и подать синхроимпульс, чтобы начать считывать записанное число необходимо на вход STLD подать логическую 1 и подавать синхроимпульсы.
Записать число в интервале от 32 до 56 в параллельном коде и поразрядно считывать его на выходе. Записать результат в отчёт. 
4 Содержание отчёта 
4.1 Цель работы. 
4.2 Схема исследования параллельного 4-х битного регистра с таблицей 3.1 . 
4.3 Схема последовательно-параллельного регистра с результатами исследований. 
4.4 Выводы по каждому заданию. 
5 Контрольные вопросы 
5.1 Назначение регистров. 
5.2 По каким признакам классифицируются регистры? 
5.3 Чем определяется разрядность регистров? 
5.4 Назначение параллельного регистра. 
5.5 Объяснить принцип работы последовательного регистра. 
5.6 Объяснить принцип работы параллельного регистра. 
5.7 Объяснить принцип работы последовательно-параллельного регистра. 
5.8 Объяснить принцип работы параллельно-последовательного регистра. 



[bookmark: _Toc351203215]Практическая работа 10. Исследование триггеров
1 Цель работы: 
Целью работы является экспериментальное исследование работы различных типов триггеров. 
2 Краткие теоретические сведения
Триггеры предназначены для запоминания двоичной информации. Использование триггеров позволяет реализовывать устройства оперативной памяти (то есть памяти, информация в которой хранится только на время вычислений). Однако триггеры могут использоваться и для построения некоторых цифровых устройств с памятью, таких как счётчики, преобразователи последовательного кода в параллельный или цифровые линии задержки. 
2.1 RS-триггер
Основным триггером, на котором базируются все остальные триггеры является RS-триггер.
RS-триггер имеет два логических входа:
1. R - установка 0 (от слова reset); 
1. S - установка 1 (от слова set). 

RS-триггер имеет два выхода: 
1. Q - прямой; 
1. Q- обратный (инверсный). 

Состояние триггера определяется состоянием прямого выхода. Простейший RS-триггер состоит из двух логических элементов, охваченных перекрёстной положительной обратной связью (рисунок 2.1). 

Рисунок 2.1 - Схема простейшего RS- триггера 

Рассмотрим работу триггера:
Пусть R=0, S=1. Нижний логический элемент выполняет логическую функцию ИЛИ-НЕ, т.е. 1 на любом его входе приводит к тому, что на его выходе будет логический ноль Q=0. На выходе Q будет 1 (Q=1), т.к. на оба входа верхнего элемента поданы нули (один ноль - со входа R, другой - с выхода ). Триггер находится в единичном состоянии. Если теперь убрать сигнал установки (R=0, S=0), на выходе ситуация не изменится, т.к. несмотря на то, что на нижний вход нижнего логического элемента будет поступать 0, на его верхний вход поступает 1 с выхода верхнего логического элемента. Триггер будет находиться в единичном состоянии, пока на вход R не поступит сигнал сброса. Пусть теперь R=1, S=0. Тогда Q=0, а =1. Триггер переключился в "0". Если после этого убрать сигнал сброса (R=0, S=0), то все равно триггер не изменит своего состояния.
Для описания работы триггера используют таблицу состояний (переходов).
Обозначим:
1. Q(t) - состояние триггера до поступления управляющих сигналов (изменения на входах R и S); 
1. Q(t+1) - состояние триггера после изменения на входах R и S.
Таблица 2.1 - Таблица переходов RS триггера в базисе ИЛИ-НЕ 
	R
	S
	Q(t)
	Q(t+1)
	Пояснения

	0
	0
	0
	0
	Режим хранения информации R=S=0

	0
	0
	1
	1
	

	0
	1
	0
	1
	Режим установки единицы S=1

	0
	1
	1
	1
	

	1
	0
	0
	0
	Режим установки нуля R=1

	1
	0
	1
	0
	

	1
	1
	0
	*
	R=S=1 запрещённая комбинация

	1
	1
	1
	*
	



RS-триггер можно построить и на элементах "И-НЕ" (рисунок 2.2).

Рисунок 2.2 - Схема RS-триггера, построенного на схемах "2И-НЕ" 
Входы R и S инверсные (активный уровень "0"). Переход (переключение) этого триггера из одного состояния в другое происходит при установке на одном из входов "0". Комбинация R=S=0 является запрещённой. 
Таблица 2.2 - Таблица переходов RS триггера в базисе "2И-НЕ" 
	R
	S
	Q(t)
	Q(t+1)
	Пояснения

	0
	0
	0
	*
	R=S=0 запрещённая комбинация

	0
	0
	1
	*
	

	0
	1
	0
	0
	Режим установки нуля R=0

	0
	1
	1
	0
	

	1
	0
	0
	1
	Режим установки единицы S=0

	1
	0
	1
	1
	

	1
	1
	0
	0
	Режим хранения информации R=S=1

	1
	1
	1
	1
	


2.2 Синхронный RS-триггер
Схема RS-триггера позволяет запоминать состояние логической схемы, но так как при изменении входных сигналов может возникать переходный процесс (в цифровых схемах этот процесс называется "опасные гонки"), то запоминать состояния логической схемы нужно только в определённые моменты времени, когда все переходные процессы закончены, и сигнал на выходе комбинационной схемы соответствует выполняемой ею функции. Это означает, что большинство цифровых схем требуют сигнала синхронизации (тактового сигнала). Все переходные процессы в комбинационной логической схеме должны закончиться за время периода синхросигнала, подаваемого на входы триггеров. Триггеры, запоминающие входные сигналы только в момент времени, определяемый сигналом синхронизации, называются синхронными. Принципиальная схема синхронного RS триггера приведена на рисунке 2.3.

Рисунок 2.3 - Схема синхронного RS-триггера

Таблица 2.3 - Таблица переходов синхронного RS-триггера 
	R
	S
	C
	Q(t) 
	Q(t+1)
	Пояснения

	0
	0
	1
	0
	0
	Режим хранения информации
R = S = 0

	0
	0
	1
	1
	1
	

	0
	1
	1
	0
	1
	Режим установки единицы S =1

	0
	1
	1
	1
	1
	

	1
	0
	1
	0
	0
	Режим установки нуля R=1

	1
	0
	1
	1
	0
	

	1
	1
	1
	0
	*
	R = S = 1 запрещённая комбинация

	1
	1
	1
	1
	*
	


[bookmark: D_tr]В таблице 2.3. под сигналом С подразумевается синхроимпульс. Без синхроимпульса синхронный RS триггер сохраняет своё состояние. 
2.3 D - триггер
D-триггер имеет 1 информационный вход (D-вход). Бывают только синхронные D-триггеры. Состояние информационного входа передаётся на выход под действием синхроимпульса (вход С).

Рисунок 2.4 - Схема D-триггера на основе синхронного RS-триггера

Таблица 2.4 - Таблица переходов D-триггера 
	C
	D
	Q(t)
	Q(t+1)
	Пояснения

	0
	*
	0
	0
	Режим хранения информации

	0
	*
	1
	1
	

	1
	0
	*
	0
	Режим записи информации

	1
	1
	*
	1
	



Если на входе D - "1", то по приходу синхроимпульса Q = 1.
Если на D "0", то Q =0. 
2.4 Счётный триггер (Т-триггер)
Т-триггер имеет один счётный информационный вход.Триггер переключается каждый раз в противоположное состояние, когда на вход Т поступает управляющий сигнал. 
Таблица 2.5 - Таблица переходов Т триггера 
	T
	Q(t)
	Q(t+1)

	0
	0
	0

	0
	1
	1

	1
	0
	1

	1
	1
	0




Рисунок 2.5 - Схема T-триггера на основе двухступенчатого D-триггера

2.5 Универсальный триггер (JK-триггер)
Такой триггер имеет информационные входы J и К, которые по своему влиянию аналогичны входам S и R тактируемого RS-триггера: 
1. при J=1, K=0 триггер по тактовому импульсу устанавливается в состояние Q=1; 
1. при J= 0, К=1 - переключается в состояние Q=0; 
1. при J=K=0 - хранит ранее принятую информацию. 
Но в отличие от синхронного RS-триггера одновременное присутствие логических 1 на информационных входах не является для JK-триггера запрещённой комбинацией и приводит триггер в противоположное состояние. 

Рисунок 2.6 - Схема JK-триггера на основе двухступенчатого синхронного RS-триггера.

Таблица 2.6 - Таблица переходов JK триггера 
	K
	J
	C
	Q(t)
	Q(t+1)

	0
	0
	1
	0
	0

	0
	0
	1
	1
	1

	0
	1
	1
	0
	1

	0
	1
	1
	1
	1

	1
	0
	1
	0
	0

	1
	0
	1
	1
	0

	1
	1
	1
	0
	1

	1
	1
	1
	1
	0



3 Задание к работе 
3.1 Исследовать асинхронный RS- триггер.
Сконфигурировать ПЛИС в соответствии с рисунком 3.1. 

Рисунок 3.1 - RS-триггер на основе логических элементов "ИЛИ-НЕ"
Все используемые элементы располагаются в Symbol tools->Primitives.
Устанавливая с помощью переключателей S7 и S8 различные комбинации логических уровней и наблюдая за светодиодом LED8 заполнить таблицу 3.1 
Таблица 3.1 - Таблица переходов для асинхронного 
RS триггера на элементах "ИЛИ-НЕ"
	R
	S
	Q(t)
	Q(t+1)

	0
	0
	0
	 

	0
	0
	1
	 

	0
	1
	0
	 

	0
	1
	1
	 

	1
	0
	0
	 

	1
	0
	1
	 


3.2 Исследовать синхронный RS триггер.
Сконфигурировать ПЛИС в соответствии с рисунком 3.2.

Рисунок 3.2 - Синхронный RS-триггер
Триггер взять из библиотеки Primitives->Storage. Устанавливая с помощью переключателей S7 и S8 различные комбинации логических уровней и затем нажимая на кнопку Button, заполнить таблицу переходов 3.2. 
Таблица 3.2 - Таблица переходов для синхронного RS триггера 
	R
	S
	C
	Q(t)
	Q(t+1)

	0
	0
	1
	0
	 

	0
	0
	1
	1
	 

	0
	1
	1
	0
	 

	0
	1
	1
	1
	 

	1
	0
	1
	0
	 

	1
	0
	1
	1
	 

	0
	0
	0
	0
	 

	0
	0
	0
	1
	 

	0
	1
	0
	0
	 

	0
	1
	0
	1
	 

	1
	0
	0
	0
	 

	1
	0
	0
	1
	 


3.3 Исследовать D-триггер
Сконфигурировать ПЛИС в соответствии с рисунком 3.3. 

Рисунок 3.3 - Схема D-триггера
Устанавливая с помощью переключателя S8 различные логические уровни на выходе D и затем нажимая на кнопку Button, заполнить таблицу переходов 3.3. 
Таблица 3.3 - Таблица переходов для синхронного D триггера 
	D
	C
	Q(t)
	Q(t+1)

	*
	0
	0
	 

	*
	0
	1
	 

	0
	1
	0
	 

	1
	1
	1
	 


3.4 Исследовать синхронный T-триггер
Сконфигурировать ПЛИС в соответствии с рисунком 3.4. 

Рисунок 3.4 - Схема счётного Т-триггера
Блок Antitinkling необходим для подавления дребезга кнопки. 
ВНИМАНИЕ! Для того, что бы выполнить блок Antitinkling, прочтите инструкцию Борьба с дребезгом контактов 
Вход CLK соединяется с pin16, вход Button соединяется с pin37. Выход Antitinkling соединить с входом синхронизации триггера. Остальные входы соединить согласно рисунку 3.4.
Устанавливая с помощью переключателя S8 различные логические уровни на выходе D и затем, нажимая на кнопку Button, заполнить таблицу переходов 3.4. 
Таблица 3.4 - Таблица переходов для синхронного D триггера 
	T
	C
	Q(t)
	Q(t+1)

	1
	1
	0
	 

	1
	1
	1
	 

	0
	1
	0
	 

	0
	1
	1
	 


3.5 Исследование синхронного JK триггера
Сконфигурировать ПЛИС в соответствии с рисунком 3.5. 

Рисунок 3.5 - Схема JK-триггера 

Блок Antitinking подключить так же как, было сделано в предыдущем задании. Устанавливая с помощью переключателя S7 и S8 различные логические уровни на входах J, K и затем, нажимая на кнопку Button, заполнить таблицу переходов 3.5. 
Таблица 3.5 - Таблица переходов для JK триггера 
	J
	K
	C
	Q(t)
	Q(t+1)

	0
	0
	1
	0
	 

	0
	0
	1
	1
	 

	0
	1
	1
	0
	 

	0
	1
	1
	1
	 

	1
	0
	1
	0
	 

	1
	0
	1
	1
	 

	1
	1
	1
	0
	 

	1
	1
	1
	1
	 



4 Содержание отчёта 
4.1 Цель работы. 
4.2 Схемы исследования триггеров. 
4.3 Привести условные графические обозначения исследуемых триггеров.
4.4 Таблица переходов исследуемых триггеров. 
4.5 Выводы по каждому заданию. 
5 Контрольные вопросы 

5.1 Чем определяется быстродействие триггера? 
5.2 Начертить схему RS-триггера на логических элементах "ИЛИ-НЕ" и пояснить принцип его работы. 
5.3 Почему JK-триггер называется универсальным? 
5.4 Пояснить по таблице переходов работу D-триггера.
5.5 Какой характерной особенностью обладает периодическая последовательность импульсов на входе T-триггера? 
5.6 Способы описания последовательных цифровых устройств. 
5.7 Каким преимуществом обладает двухступенчатый триггер? 



[bookmark: _Toc351203216]Практическая работа 11. Исследование двоичных счетчиков

1 Цель работы: Целью работы является изучение универсального двоичного счётчика и приобретение навыков в построении и экспериментальном исследовании счётчиков. 
2 Краткие теоретические сведения 
Счётчик – устройство для подсчёта числа входных импульсов.
Параметры счётчика:
1. модуль счёта М – число устойчивых состояний; 
1. ёмкость Е – максимальное число, которое может быть записано в счётчик (Е=М-1); 
1. быстродействие (скорость перехода из состояния «все 1» в состояние «все 0» и наоборот). 
Классификация:
1 По направлению счёта: 
1. суммирующие; 
1. вычитающие; 
1. реверсивные; 
2 По способу построения цепи переноса: 
1. с последовательным переносом; 
1. с параллельным переносом; 
1. с комбинированным переносом; 
3 По способу переключения триггера: 
1. синхронные; 
1. асинхронные. 
2.1 Простейший суммирующий асинхронный счётчик
Счётчик представляет собой несколько последовательно включенных счётных триггеров. Напомним, что по каждому входному импульсу счётный триггер изменяет своё состояние на противоположное. 

Рисунок 2.1 – Простейший суммирующий асинхронный счётчик
Если вход синхроимпульса триггера отмечен как «\», то опрокидывание триггера происходит по заднему фронту, если как «/» - то по переднему. 

Рисунок 2.2 – Временная диаграмма работы суммирующего асинхронного счётчика
Для того чтобы разобраться, как работает схема двоичного счётчика, воспользуемся временными диаграммами сигналов на входе и выходах этой схемы, приведёнными на рисунке 2.2.
Пусть первоначальное состояние всех триггеров счётчика будет нулевым. Это состояние мы видим на временных диаграммах. Запишем его в таблицу 2.1. После поступления на вход счётчика тактового импульса (который воспринимается по заднему фронту) первый триггер изменяет своё состояние на противоположное, то есть единицу.
Запишем новое состояние выходов счётчика в ту же самую таблицу. Так как по приходу первого импульса изменилось состояние первого триггера, то этот триггер содержит младший разряд двоичного числа (единицы).
Таблица 2.1 – Изменение уровней на выходе суммирующего двоичного счётчика при поступлении на его вход импульсов 
	Номер входного импульса
	Q2
	Q1
	Q0

	1
	0
	0
	1

	2
	0
	1
	0

	3
	0
	1
	1

	4
	1
	0
	0

	5
	1
	0
	1

	6
	1
	1
	0

	7
	1
	1
	1

	8
	0
	0
	0


Подадим на вход счётчика ещё один тактовый импульс. Значение первого триггера снова изменится на прямо противоположное. На этот раз на выходе первого триггера, а значит и на входе второго триггера сформируется задний фронт. Это означает, что второй триггер тоже изменит своё состояние на противоположное. Это отчётливо видно на временных диаграммах, приведённых на рисунке 2.2. Запишем новое состояние выходов счётчика в таблицу 2.1. В этой строке таблицы образовалось двоичное число 2. Оно совпадает с номером входного импульса.
Продолжая анализировать временную диаграмму, можно определить, что на выходах приведённой схемы счётчика последовательно появляются цифры от 0 до 7. Эти цифры записаны в двоичном виде. При поступлении на счётный вход счётчика очередного импульса, содержимое его триггеров увеличивается на 1. Поэтому такие счётчики получили название суммирующих двоичных счётчиков. Если информацию снимать с инверсных выходов триггеров, то получится вычитающий счётчик. 
2.2 Простейший вычитающий асинхронный счётчик
Рассмотрим схему счётчика на триггерах, опрокидывающихся по переднему фронту входных импульсов рисунок 2.3 

Рисунок 2.3 – Вычитающий счётчик

Рисунок 2.4 – Временная диаграмма
Из временной диаграммы видим, что получился вычитающий счётчик. Если информацию снимать с инверсных выходов триггеров, то получится суммирующий счётчик. 
2.3 Счётчик с произвольным модулем счёта
Для построения такого счётчика можно использовать двоичный счётчик, у которого модуль счёта М должен быть больше модуля счёта разрабатываемого счётчика с произвольным модулем счёта.
Пусть нужно сделать счётчик с М= 10.
У 4-х разрядного счётчика модуль счёта равен 16 (больше 10).
Схема счётчика представляет собой 4 последовательно включённых счётных триггера, у которых есть вход сброса R.
Число 10 в двоичной системе счисления представляется 1010. Когда на выходах счетчика будет код 1010, на выходе элемента «И» появится логическая единица, которая запустит схему гашения. Длительность импульса на выходе схемы гашения должна быть достаточна для надёжного сброса всех триггеров счётчика в 0. Разряды числа 1010, равные 1 подаются на схему «И» с прямых выходов триггеров, а равные 0 - с инверсных. Таким образом, как только счётчик досчитает до 10, произойдёт обнуление всех триггеров и счёт продолжится с кода 0000. 

Рисунок 2.5 – Счётчик с модулем счета М=10
Рассмотрим счётчик с М=11 на основе двоичного счётчика в одной микросхеме (без инверсных выходов). 
1110=10112 

Рисунок 2.6 – Счётчик с модулем счёта М=11 
В качестве схемы гашения может быть RS-триггер. 

Рисунок 2.7 – Счётчик с модулем счёта М=17
В этой схеме М=100012 = 1710
Сигнал на входе К счётчика будет действовать в течение одного периода входных импульсов 
3 Задание к работе
3.1 Исследовать суммирующий счётчик.
Сконфигурировать ПЛИС в соответствии с рисунком 3.1. 

Рисунок 3.1 – Схема суммирующего счётчика
Элемент 74393 представляет собой суммирующий счётчик. 
ВНИМАНИЕ! Для того, что бы выполнить блок Antitinkling, прочтите инструкцию Борьба с дребезгом контактов. 
Подавая с помощью кнопки Button на вход счётчика импульсы и наблюдая за выходами Q, заполнить таблицу 3.1. 
Таблица 3.1 – Таблица состояний суммирующего счётчика 
	Номер входного импульса
	QD
	QC
	QB
	QA

	0
	 
	 
	 
	 

	1
	 
	 
	 
	 

	...
	 
	 
	 
	 

	15
	 
	 
	 
	 


3.2 Исследовать вычитающий счётчик.
Сконфигурировать ПЛИС в соответствии с рисунком 3.2. 

Рисунок 3.2 – Схема вычитающего счётчика
Элемент 4 count представляет собой вычитающий 4-х разрядный счётчик. 
Подавая с помощью кнопки Button на вход счётчика импульсы и наблюдая за выходами, заполнить таблицу 3.2. 
Таблица 3.2 – Таблица состояний вычитающего счётчика 
	Номер входного импульса
	QD
	QC
	QB
	QA

	0
	 
	 
	 
	 

	1
	 
	 
	 
	 

	...
	 
	 
	 
	 

	15
	 
	 
	 
	 


3.3 Исследовать счётчик с произвольным модулем счёта.
В соответствии с вариантом, полученным у преподавателя, разработать схему счётчика с заданным модулем счёта. В соответствии с разработанной схемой сконфигурировать ПЛИС. На рис 3.3 приведён пример схемы счётчика с модулем счёта 8. К выходам счётчика через преобразователь кодов 74247 подключён семисегментный индикатор. 
Подавая с помощью кнопки Button на вход счетчика импульсы и наблюдая за выходами QA, QB, QC, QD и цифровым индикатором, заполнить таблицу 3.3. 
Таблица 3.3 – Таблица состояний счётчика с произвольным модулем счёта 
	Номер входного импульса
	QD
	QC
	QB
	QA
	Цифра на индикаторе

	0
	 
	 
	 
	 
	 

	1
	 
	 
	 
	 
	 

	...
	 
	 
	 
	 
	 

	15
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Рисунок 3.3 – Схема счётчика с модулем счёта 8 

4 Содержание отчёта 
4.1 Цель работы. 
4.2 Схема исследования суммирующего счётчика с таблицей состояний. 
4.3 Временные диаграммы входных и выходных импульсов суммирующего счётчика. 
4.4 Схема исследования вычитающего счётчика с таблицей состояний. 
4.5 Временные диаграммы входных и выходных импульсов вычитающего счётчика. 
4.6 Схема исследования счётчика с произвольным модулем счёта. 
4.7 Временные диаграммы входных и выходных импульсов счётчика с произвольным модулем счёта. 
4.8 Выводы по каждому заданию. 
5 Контрольные вопросы 
5.1 Объяснить принцип работы суммирующего счётчика. 
5.2 Изобразить временные диаграммы работы суммирующего счётчика. 
5.3 Объяснить принцип работы вычитающего счётчика. 
5.4 Изобразить временные диаграммы работы вычитающего счётчика. 
5.5 Объяснить принцип работы счётчика с произвольным модулем счёта. 
5.6 Рассказать о классификации счётчиков. 
5.7 Где применяются счётчики? 




1. Грушвицкий Р.И., Мурсаев А.X. Угрюмов Е.П. Проектирование систем на микросхемах программируемой логики. — СПб.: БХВ-Петербург, 2002.
2. Угрюмов Е.П. Цифровая схемотехника. – СПб.: БХВ, 2000.




[bookmark: _Toc351203217]Практическая работа 12. Создание элементов на базе макрофункций

Цель работы: научиться создавать элементы схем на базе стандартных макрофункций системы QUARTUS

Шаг 1: Создание нового проекта для использования в цикле лабораторных работ. 

2. Запустите САПР Quartus II. В меню Пуск выберите Все программы  Altera  Quartus II 7.2.  Quartus II 7.2 (32-Bit), для запуска. 
3. Вызовите утилиту New Project Wizard. В меню File выберите New Project Wizard…. Откроется новое окно. Если на экране появилось страница Introduction, нажмите Next. 
4. Приступите к созданию проекта с помощью утилиты New Project Wizard. На странице 1 задайте информацию, представленную в таблице 1. 

Таблица 1. Настройки страницы 1 New Project Wizard 
	Рабочая директория проекта
	<lab_install_directory> \Pipemult\ 

	Имя проекта 
	pipemult 

	Файл верхнего уровня иерархии
	pipemult 


 
Страница 1 утилиты New Project Wizard должна выглядеть подобным образом. 

6. Нажмите Next, чтобы перейти на следующую страницу. 
7. На странице 2 нажмите кнопку  и выберите файл верхнего уровня иерархии pipemult.bdf. Он располагается в рабочей директории проекта. Нажмите Open, затем Add, чтобы добавить файл в проект. Нажмите Next. 

Обратите внимание, данное  действие не является обязательным, т. к. данный файл уже находится в рабочей директории. Новый проект автоматически подключил бы его как составную часть проекта. Добавление файлов или каталогов с файлами (библиотеками) необходимо выполнять в том случае, если они не находятся в рабочей директории проекта. 

 

7. На странице 3, выберите семейство (Family) Cyclone II. В правой части окна, в разделе Show in ‘Available device’ list, установите следующие значения: в строке Package выберите FBGA, Pin count выберите 256, Speed grade выберите Fastest. Эти настройки ограничивают список доступных микросхем. В окне Available devices выберите микросхему EP2C5F256C6. Нажмите Next.

 

8. На странице 4 (см. выше), вы можете указать дополнительно используемые САПР сторонних производителей. В данном цикле упражнений мы работаем только в среде Quartuis II. Нажмите Next для продолжения. 

 

9. Перед собой вы видите итоговую страницу. Нажмите Finish. Проект создан. 
Выходить из среды Quartus II нет необходимости, если вы собираетесь продолжить выполнение упражнения. Закрытый проект всегда модно открыть с помощью команды File  Open Project. Команда File  Open позволяет открыть отдельный файл (вместо проекта), предотвращая выполнение различных действий, связанных с обработкой проекта, например компиляцию. 

Разработка конвейерного умножителя. 

На рисунке 1 изображено схематическое представление файла верхнего уровня иерархии, который вы должны реализовать. Он состоит из умножителя и блока оперативной памяти RAM. Данные подаются на умножитель от внешнего источника,  а результат сохраняется в блоке памяти, который тоже управляется от  внешнего источника. Затем данные читаются из блока оперативной памяти, используя независимую шину адреса для чтения. 

 
Рисунок 1. 

Шаг 1: Создайте умножитель 8х8 с помощью утилиты MegaWizard® Plug-in Manager. 
2. Выберите Tools  MegaWizard Plug-In Manager. В открывшемся окне выберите опцию Create a new custom megafunction variation. Нажмите Next. 



3. Выберите нужную мегафункцию. На странице 2 (как показано выше), раскройте папку Arithmetic и выберите LPM_MULT. 
4. В выпадающем меню справа укажите используемое семейство микросхем Cyclone II. 
Выбор семейства микросхем позволяет утилите MegaWizard Plug-In Manager определить ее доступные ресурсы и доступные мегафункции для него. Можно создать мегафункцию для другого семейства микросхем, при этом  необходимо выбрать соответствующее семейство и создать для него новый проект. 

4. Выберите язык описания интерфейса мегафункции (VHDL или Verilog HDL) и укажите рабочую директорию, где будет сохранена мегафункция. Если вы разрабатываете схемотехнический проект, выберите VHDL или Verilog по желанию. 
5. Задайте имя выходного файла – mult. Вы можете добавить его в конце выбранного пути к нужной директории или не указывать полный путь для автоматического сохранения файла в рабочей директории проекта. 
6. Нажмите Next. 
 

5. На странице 3 (General) укажите разрядность входных шин данных dataa и datab (они могут быть установлены автоматически). В нашем примере разрядность 8 бит. Нажмите Next. 

 

6. На странице 4 (General 2) оставьте все настройки по умолчанию (datab не является константой, используется беззнаковое умножение и способ реализации умножителя выбирается по умолчанию). Нажмите Next. 

 

7. На странице 5 (Pipelining) выберите Yes, I want an output latency of 2 clock cycles (задержка выдачи результата на 2 цикла тактовой частоты). Нажмите Next. 
 

8. Сейчас вы должны перейти на страницу 6 (вторая закладка - EDA). Здесь указывается файл Lpm, который используется сторонними САПР для моделирования мегафункции LPM_MULT (например, в САПР ModelSim-Altera). В нашем упражнении мы не будем применять сторонние САПР для моделирования. Нажмите Next.


 

11. На странице 7 необходимо отметить создаваемые файлы согласно таблице 2, приведенной ниже: 

	Тип исходного файла проекта
	Файлы, которые необходимо создать в MegaWizard Plug-In

	Schematic
	mult(.vhd or .v) & mult.bsf




12. Нажмите Finish для завершения создания мегафункции. 
       Умножитель создан. 
Если, по некоторым причинам, мегафункция создана некорректно или вы что-то пропустили, откройте снова MegaWizard Plug-In Manager в меню Tools. Выберите опцию редактирования мегафункции и исправьте ошибки. Нажмите Finish. 

Шаг 2: Создайте 32x16 RAM с помощью утилиты MegaWizard Plug-In Manager 
2. Еще раз откройте MegaWizard Plug-In Manager (Tools  MegaWizard Plug-In Manager). Выберите Create a new custom megafunction variation и нажмите Next. 
 
5. Выберите соответствующую мегафункцию. На странице 2 (см. выше) раскройте папку Memory Compiler и выберите RAM: 2-PORT. 
6. Как и для реализации умножителя, выберите семейство микросхем Cyclone II и язык файла описания мегафункции - VHDL или Verilog HDL. 
7. В строке имени выходного файла укажите ram. 
8. Нажмите Next. 
 

6. На странице 3, выберите With one read port and one write port, в разделе указания способа использования двухпортовой памяти. Остальные настройки оставьте по умолчанию (размер памяти определяется количеством слов). Нажмите Next. 

 

7. На странице 4 (Widths/Blk Type), установите разрядность входного порта data_a равную 16 бит (в разделе Read/Write Ports). Затем выберите 32 - количество 16-разрядных слов памяти (16-bit words of memory). Примечание: вы будете видеть надпись “8-bit words of memory” до тех пор, пока не измените значение разрядности входного порта. Остальные настройки оставьте по умолчанию. Нажмите Next 2 раза. 

 

7. На странице 6 (Regs/Clkens/Aclrs), отключите опцию Read output port(s) ‘q’, чтобы исключить установку выходных регистров для порта q. Остальные настройки оставьте по умолчанию и нажмите Next 2 раза. 

 

8. На странице 8 (Mem Init) выберите Yes, чтобы указать файл инициализации блока памяти. После того, как поле стало доступным, впишите имя файла: ram.hex. Мы создадим этот файл позже, но нам ничего не мешает указать сейчас его имя. Нажмите Next. 
9. На странице 11 отображается файл altera_mf, необходимый для моделирования этой мегафункции с помощью сторонних САПР. Нажмите Next. 
10. Выберите те же файлы для создания мегафункции ram, которые вы выбирали для мегафункции mult ранее (Шаг 1, пункт 11) 

Теперь у вас есть два созданных компонента, необходимых для данного проекта. Далее необходимо создать НЕХ файл, описывающий содержимое для инициализации оперативной памяти RAM. 

Шаг 3: Создайте НЕХ файл с помощью редактора Memory Editor 
10. В меню File выберите команду New или нажмите знак  в рабочей панели инструментов. 

 
12. В открывшемся диалоговом окне перейдите к закладке Other Files и выберите Hexadecimal (Intel-Format) File. Нажмите OK. 
 

13. В диалоговом окне настроек размера области памяти установите следующие значения: количество слов – number of words – 32, размер слова – word size – 16. Нажмите Ok. 

 
Открывшееся окно редактора памяти Memory Editor отображает заданное вами пространство памяти. Если пространство памяти отображается не так, как показано выше, можно изменить количество ячеек в ряду (меню View) на 16 и формат отображаемых значений на Hexadecimal. 

4. Выделите всю область памяти, нажмите правую кнопку мыши и выберите Custom Fill Cells в открывшемся контекстном меню. 
5. С помощью диалогового окна Custom Fill Cells, введите нужные значения для инициализации области памяти. Можно выбрать одно из следующих действий: 
· Повторяющаяся последовательность: Введите последовательность значений, которые будут повторяться в памяти, отделяя их пробелом или запятой. 
· Нарастающая/убывающая последовательность: Введите начальное значение и значение величины, на которую будет изменяться каждое последующее значение (увеличиваться или уменьшаться). 
6. Сохраните файл как ram.hex. Закройте его. 
Добавьте блоки в проект и создайте нужные связи. 
1. Откройте файл pipemult.bdf. Можно использовать команду Open в меню File, или нажать значок  на рабочей панели инструментов, или дважды нажать на имени файла в окне навигатора проекта Project Navigator. 
Это файл верхнего уровня иерархии для данного проекта. На самом деле, вам было бы необходимо выбрать блоки ram и mult и выполнить вручную их соединение. В интересах экономии времени, для вас создан почти завершенный файл, который не имеет блоков ram и mult, а также выходной шины q[15..0]. 
2. Нажмите дважды левой кнопкой мыши в любом свободном месте схемотехнического окна. В открывшемся окне Symbol, нажмите , чтобы раскрыть папку Project. Дважды нажмите левой кнопкой мыши на элементе mult. Затем нажмите левую клавишу мыши в поле чертежа, чтобы вставить выбранный элемент в указанное место. 
Примечание: Три входных порта в левой части умножителя должны совпадать со входами, присутствующими на схеме. Если это не так, вы возможно, неправильно создали мегафункцию. В этом случае нажмите Esc, чтобы отменить вставку символа, откройте снова утилиту MegaWizard Plug-In Manager и выберите опцию Edit an existing megafunction variation. Укажите элемент mult и исправьте ошибки. Повторите установку символа в нужном месте. 
3. Правой клавишей мыши нажмите на блок mult и выберите команду Properties в контекстном меню. В диалоговом окне Symbol Properties, в строке Instance name, измените имя inst на mult_inst. Нажмите OK. 
4. Снова откройте окно Symbol. Выберите элемент ram и установите его в указанное место. 
Примечание: 4 нижних входа блока ram должны совпасть с входными портами. Вход data должен остаться не подключенным. 
5. Также, как и для блока mult, для элемента ram откройте диалоговое окно Symbol Properties и измените имя inst на ram_inst. 
6. Откройте окно Symbol и в строке Name введите имя элемента output. Элемент должен определиться автоматически. 
7. Нажмите OK и установите элемент возле выходного контакта регистра inst2. Дважды щелкните в области указания имени компонента и измените pin_name на q[15..0]. 
8. Нажмите кнопку  (вызов инструмента для создания шин), затем соедините между собой выход элемента mult (result) и свободный вход элемента ram (data). 
 
В результате вы должны получить схему, представленную на рисунке выше. 
9. Сохраните файл pipemult.bdf. 

Шаг 5: Сохраните и проверьте проект 
1. В меню Processing выберите команду Start  Start Analysis & Elaboration. 
Данная команда выполняет проверку наличия всех файлов в проекте и правильность их подключений. 
2. Нажмите OK, когда анализ завершится. Если были обнаружены какие либо ошибки, проверьте все связи или повторно вызовите MegaWizard Plug-In Manager для исправления ошибок в мегафункциях.



Контрольные вопросы:

1. Порядок создания элементов из библиотеки макрофункций в QuartusII 
2. Рааскажите о свойствах элементов библиотеки.
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